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Quick Start Guide

Quick Start Guide
This document is intended to help first-time IceWarp Server users to get familiar with the IceWarp Server administration
interface and basic features using the hands-on method of an initial software setup.
It will also showcase the extra benefits of using IceWarp Server over other – similar – products.
If you have not already read our Installation Guide for Windows, download it at the IceWarp website:
https://www.icewarp.com/download-premise/guides/, section "Installation". A specific installation guide is available for IceWarp
Linux – Installation and Control in Linux Guide.
This document refers to IceWarp Server for Windows, however it can also be useful for Linux customers.
Latest revision of manuals is available on the IceWarp website http://www.icewarp.com, in the Guides section.

Registered Trademarks
iPhone, iPad, Mac, OS X are trademarks of Apple Inc., registered in the U.S. and other countries. Microsoft, Windows, Outlook and
Windows Phone are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other
countries. Android is a trademark of Google Inc. IceWarp is a registered trademark in the USA and other countries.
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Getting Started
This chapter describes essential steps needed to use IceWarp Server from its download to a full functionality.

Download
Download the IceWarp Server full setup package that contains everything necessary to run the product from
https://www.icewarp.com/download-premise/server/.

Installation
To install IceWarp Server, run the installation file. For detailed information about server installation, refer to the IceWarp Server
Installation Guide.

Wizard
To go through the server installation process step by step, refer to the Installation Guide – Launch Installer Wizard chapter.

Activation
For description of either online activation or offline one, refer to the Installation Guide – License Registration chapter.

Add Domain
To create a new domain, follow instructions in the Create New Domain (on page 18) chapter and the Domains and Accounts –
Management – Domains one.

Network
To manage DNS records, use information in both the Networking (on page 6) and DNS Records (on page 16) chapter.

Add Users
Adding users is an essential domain operation. For description, refer to the Create New User Account (on page 20) chapter plus
Create Administrator Account (on page 19) one. Find detailed GUI description in the User Accounts chapter.

Login to WebClient
The most significant IceWarp Server part from the user's point of view is IceWarp WebClient. Provide your users with a simple
description of WebClient login process. Find it in the Logging into IceWarp WebClient chapter.

Useful Links
To enhance your server knowledge, you can use many additional sources:
Join the IceWarp Server Community and forums – http://forum.icewarp.com/forum/
Find the latest presentations and webinars – http://www.youtube.com/icewarp
If you are in any doubt or need assistance, ask IceWarp Support staff online – https://www.icewarp.com/support/iw-license/
Download related documents – https://www.icewarp.com/download-premise/guides/ (use both Server and Clients tabs).
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Requirements
Hardware
IceWarp Server can run well on fairly modest hardware.
For a basic service (a few hundred user accounts), a Pentium class processor and 4GB RAM will suffice.
If you plan to have thousands of users, or expect heavy traffic, you should consider a multi-CPU system with 16 GB RAM, and a
fast disk sub-system (SAN, Fast iSCSI or DAS with 15k RPM SAS drives).
RAID is beneficial only if you require top data integrity or if configured to maximize disk I/O speed, RAID10 and RAID1 offer best
disk read/write speeds (IOPS).
An fast external file server for data storage and backup is recommended for ISP-class installations.
More details at https://www.icewarp.com/product/technical-specification/.

Software
IceWarp Server installer is almost everything you need.
IceWarp Server runs on any server (starting 2008) or desktop (starting 2007) Windows OS.
Install and run IceWarp Server of the same bittness as your operating system is.
IceWarp WebClient will not work on the integrated webserver under Windows 2000/NT server as the required version of PHP is
not available for NT4.
IceWarp Server uses either native or ODBC driver for database connectivity and direct connection for MySQL databases (faster).
IceWarp Server always supports only official/stable releases of database engines:


ships with the latest SQLite version



supports MySQL 5.x via native driver



supports Firebird 2.5 via native driver



supports MS Access 2008 (not recommended), MS SQL 2005 – 2017, Oracle 18, Postgre SQL 10
and lower using ODBC.

IceWarp Server installs its own copy of PHP. If you already have PHP installed, the two versions can clash and IceWarp WebClient
will not run. The work-around for this problem is simply to move the files php5ts.dll and/or php4ts.dll from the
windows\system32 directory to the system32\inetsrv directory.
PHP libraries are distributed along with the integrated IceWarp Web Server and won't interfere with any other installation on the
same computer.

Networking
LAN installation requires a working Ethernet connection with assigned static IP address and/or hostname.
WAN installation requires either a dial-up or permanent connection to the internet, a public (WAN) IP address and a hostname.
Your (or your ISP's) DNS server IP address is required for direct delivery of email to Internet locations.
You need to set your ISP's or company network DNS server's authoritative (A) and mail-exchange (MX) records to point to your
server. Ask your connection provider to do this for you. The records may take up to 24 hours (or even 3 days) to propagate over
the Internet, so ensure this in advance. The records look like this:
"mail server hostname" A "mail server IP address", e.g. mail.yourdomain.com A 193.179.128.218
"domain name" MX "mail server hostname" "priority number", e.g. yourdomain.com MX mail.yournewdomain.com 10
As you can see, the MX record indicates where your mail server receives mail from other servers (via port 25) and points to an A
HOST, which points to your IceWarp Server’s incoming IP.

Page 6

IceWarp Server

Quick Start Guide

Also consider adding an SPF record, which helps to avoid your email being marked as spam when sent from your IceWarp Server
to other mail servers. Details can be found at http://www.openspf.org/, but in simple terms, we show you an example of an SPF
record:
v=spf1 ip4:208.94.39.146 ip4:208.94.39.175 a:myhost.com a mx ptr ~all
Notice that we indicate a mail server outgoing IPs, A Hosts that can send mail as our domain. We also indicate to add the A
record IP of our domain itself, the IP our MXs point to and our reverse DNS IP. The ~all at the end indicates remote servers will
consider an SPF Soft fail in case an email comes form an IP other then ours. Which can make our emails be sent to spam folders
at the recipient’s server, but it really depends on the recipient server side´s implementation for checking SPF. If using a hard fail –
all, it can mean remote servers taking more drastic actions such as refusing our mail, if it doesn’t come from one of the declared
IPs.

Database Selection
From version 11.1 IceWarp Server is installed by default with the SQLite database. This database is suitable for systems with less
than 500 users. In this case, no further configuration is required. If you do not require an external database simply use SQLite.
If you suppose/intend to have more than 500 users, you are advised to use a more robust database – e. g. MS SQL or MySQL. This
is to be changed after installation – use the IceWarp Server Console.

TIP: By default, the file system for account storage and a single SQLite database for other data stores are
created. You can then create separate databases as a post-installation task and select a more powerful
database engine as needed. The advantage is that you can create separate databases for each data store,
which is more secure and allows for easier backup.
Post-install:
1. Configure the databases as outlined in the Database Installation section further.
2. In System – Storage – Accounts, select Database. If you already have existing accounts on the server,
click the Convert to DB button.
3. If you already have GroupWare or Anti-Spam data that you need to retain, use System – Tools –
Database Migration to move the respective database from SQLite to the new database created in step #1.
4. Use the Anti-Spam – General – DB Settings button to change the default Anti-Spam database.
5. Use the GroupWare – General – DB Settings button to change the default GroupWare database.
TIP: See these step-by-step guides which help you migrate from SQLite database to MySQL database:
Windows: http://www-media.icewarp.com/pdf/Database_Migration_Windows.pdf
Linux: http://www-media.icewarp.com/pdf/Database_Migration_Linux.pdf
See the console F1 help – Shared Topics – Database Settings chapter for more information.

NOTE: If you are using either of the Windows XP x64 Edition or Windows Server 2003 R2 x64 operating
systems then you may experience difficulties "seeing" any ODBC connection you set up. If you are
experiencing problems then you should use the ODBC Data Source Administrator application located at
<system root directory>\SysWOW64\odbcad32.exe and this should allow you to manage your ODBC
connections.

Supported Databases
IceWarp Server always supports only official/stable releases of database engines:


ships with SQLite3 3.7.9 native support



supports MySQL 5.x via native driver (the latest STABLE version is recommended, 5.1 is absolute minimum)
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supports Firebird 2.1 via native driver



supports MS SQL 2000/2005/2008/2012, Oracle 11, (using ODBC or unixODBC check version support with ODBC driver
vendor)



supports MariaDB (from version 10.0 for new installations)

IceWarp recommends using MySQL, Microsoft SQL or Oracle for large installations as these are more robust and capable of
handling the increased traffic.

NOTE: For MySQL and MariaDB databases, it is recommended to use the InnoDB engine (or XtraDb for
MariaDB). It is NOT recommended to use the MyISAM engine.
In such a case, you can use the ALTER TABLE command with the ENGINE parameter to switch to InnoDB. For
detailed information, refer to the appropriate MySQL web page.

Collation and Charset
All MySQL databases must be in UTF-8 character set and UTF-8 collation – "utf8_general_ci". Otherwise it could cause several
issues (problems with logging in to WebClient, some messages not displayed or displayed incorrectly, etc.) This relates to MySQL
server only: default SQLite is using it by default, MS SQL can't use UTF-8. Use the statement:
CREATE DATABASE `accounts` DEFAULT CHARACTER SET utf8 COLLATE utf8_general_ci;

Database Installation




Once the database software is installed, you need to create the following databases for use with IceWarp Server. (You can
name these whatever you would like):
•

Accounts – this DB would contain all of the domains and accounts for the system.

•

AntiSpam – this one would hold all of the spam data for whitelisting, blacklisting, spam reports, and other anti-spam
related items.

•

GroupWare – this one will hold all Contacts, Calendars, Files, Notes, Tasks and Journal information along with any
shared data or public folders created.

Database Connectivity – You can choose to use a native driver if the vendor supports this or an ODBC connection:
•

MySQL (native driver)
* Open /php/php.ini in IceWarp installation folder, copy the extension=php_pdo_mysql.dll line, create the
php.user.ini file (within the same directory), insert the line into it and uncomment it. Now, it is not overwritten
during upgrades. Within the php.ini file body, leave this line commented, but copy it, insert it into the [IceWarp]
section at the end, uncomment it (only) here and save the file.
* Copy mysql/bin/libmysql.dll to /windows/system32 folder (x86 systems), or to /windows/syswow64 folder
(x64 systems); when using 64bit database version, obtain the 32bit version of the libmysql.dll driver from
mysql.com.

•

MS SQL (ODBC driver) or MySQL (ODBC driver); (the later one is not recommended)
* Create the System DSN in Control Panel – Administrative Tools – Data Sources (ODBC) – System DSN – Add.
* If using a 64bit server and a 32bit database version, you will need to use the 32bit ODBC manager located in
%systemdrive%\Windows\SysWoW64\Odbcad32.exe

With the few small requirements met you are now ready to connect IceWarp to the shared storage and databases and complete
the setup.


Database Connections – You will need to attach IceWarp to the created databases. To do this use the [DB Settings] tab for
the items listed below:
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•

Accounts – Open the console and go to System – Storage – Accounts and click DB Settings to specify the connection
information and then test the connection, if it passes, press Create Tables. If there are no errors during table
creation, proceed to the next database.

•

Groupware – Open the console and go to Groupware – General and click DB Settings to specify the connection
information and then test the connection, if it passes, press Create Tables. If there are no errors during table
creation, proceed to the next database.

•

AntiSpam – Open the console and go to Anti-Spam – General and click DB Settings to specify the connection
information and then test the connection, if it passes, press Create Tables.

•

Errors – Check Status – Logs – Error whether there are any problems with the database setup.

Installation Process
This chapter describes two possible installations:


New Installation



Existing Installation Upgrade

For a complete walk-through of the installation procedure, read the IceWarp Server Installation Guide, please.

NOTE: SQL logs are ON during all install/upgrade tasks.

New Installation
Installing IceWarp Server is a matter of of downloading the setup installer and launching it. The installation wizard will ask you
only if interaction is necessary.

Run Installation Wizard
Double-click the setup installer to start the installation wizard.
If you install IceWarp Server for the first time, you will be asked for registration details.
Choose the drive and folder where the software will be installed. This will be the IceWarp Server root folder. It is recommended
that this folder is on your primary drive (usually C:). It does not have to reside under "Program Files", and you can also shorten
the folder name, which can help save keystrokes in larger installations where the Command Line Tool may be used more often.
If you are re-installing or upgrading, you should be sure to point to the same directory as your previous installation, otherwise
you may lose valuable information.
In the Component Selection window, you can un-check modules you do not wish to be installed. However, IceWarp Server will
automatically adjust to your license in the moment you register the software.

License Retrieval/Evaluation
To evaluate the software, obtain a free trial version from https://www.icewarp.com/download-premise/server/. You will receive
30 days of fully working up to 200 users, feature-unlimited version. You will be alerted about the trial counting down each time
you run the Administration Console.
If you do not register the software before expiration, you will be unable to change any settings in the Administration Console or
WebAdmin, but the server will continue to run for another 30 days, then the services will be stopped.
At this point you will need to activate the software with a new license (trial extension or registered version) in order to return to
a working state, retaining your original configuration and user data.
To register the software, open Administration Console, go to menu Help – License... and click the Activate License button.
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While on the Online Activation tab, enter your assigned Order ID into the corresponding field (e.g. USA20091020123456-12345678) and click Activate License.

1.

NOTE: The on-line activation assumes you have a working Internet connection, including hostname resolution, and
port 80 is not blocked by any software, such as a firewall. To test that it is the case, open your browser and access
"licenseprocessor.icewarp.com". If it loads, check that your firewall (or Windows Firewall) allows HTTP access for the
config.exe application.
Or
Switch to the Enter License Offline tab, click the Enter License File button and browse for the license.xml file you
have previously downloaded from the purchase system website, or received as attachment to the confirmation email upon completion of your order.

2.

NOTE: For the off-line activation it is crucial to have a license issued for the exact computer hardware where
it is to be installed. If you are getting Reference ID Mismatch error, go back to http://shop.icewarp.com/,
and use the License Activation option with your Order ID and the Reference ID displayed on the previous
screen.

Existing Installation Upgrade
If you are upgrading, it will stop and start services automatically to maximize availability.

Best Practices
Planning Upgrade
•

search the context help and knowledge base for relevant up-to-date articles

•

schedule downtime for server services

•

optionally, have someone skilled available to handle possible issues or negotiate a managed upgrade with the IceWarp
Support team

•

upgrades from versions older than 9.4.2 should be performed in two phases – upgrade to 9.4.2 first and make sure your
system is stable and working fine (let it run for few days), upgrade to the current (wished) version after

Prior Upgrade
•

make a backup of all user settings via IceWarp Administration Console

•

optionally, you can copy the whole installation directory without mails and logs

•

dump or copy (SQLite) all databases (skip WebClient cache – its backup is optional)

•

the goal is to be able to create the same server state as there is at the moment of backup

•

delete session data from the <install_dir>/php/temp/ directory; this step is optional, but should be done when upgrading
between major versions

•

if you are synchronizing accounts from LDAP/AD, set c_system_adsyncmaxdeletethreshold to 1 to prevent any losses of
account data

•

increase logging levels of SMTP, GroupWare, Control services to extended, make sure you log at least failed SQL queries and
API

•

any customizations made in the php.ini file should be noted, it is strongly recommended to create the php.user.ini file (read
the php.user.ini Advantages chapter (manual.chm – Shared Topics) to learn more)

Upgrade
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•

on Linux, download and untar the installer tarball, stop all running IceWarp Server services, check that all services are really
stopped and kill any running and then run install.sh located in the installer root folder

•

on Windows, close the admin console (config.exe), execute the installer wizard (it must be executed with elevated privileges,
the installer attempts to elevate itself), do not stop IceWarp Server services

•

wait for the upgrade finish, do not terminate the process unless it is stuck. Upgrade process can take long time depending on
data amount on server as well as on the server performance. Please, be patient as prematurely terminated upgrade leads to
unpredictable behavior and serious issues.

•

on Windows, it may be worthwhile to have task manager launched while running installation to see that all services are really
stopped during the process

After Upgrade
•

check error logs frequently

•

check SQL logs for errors

•

previously made customization to definition of tables in databases (enlarged column) can (in a very rare cases) lead to a
problem with data being too long to fit the column. Alter problematic columns back as they were prior the upgrade – the
installer is never shortening columns, but it may enlarge a column to a smaller size than the customization was.

•

if applicable, set the c_system_adsyncmaxdeletethreshold property back to its original value

•

try to create new event, send a test email

•

ask users for feedback

•

let the system run for few days with increased logging level for troubleshooting if required

•

if suspecting a problem, but not sure, consult it with the IceWarp Support team – damaged or inconsistent database usually
leads to rollback and data loss, the sooner such an issue is identified the better

SQLite Database
When server upgrade from version 10 to version 11 is performed (in the case you use a database as an account storage), the
D_IP database column is converted from VARCHAR(16) to VARCHAR(46).
If you use the SQLite database, this conversion is not done (because of SQLite "liteness"). To workaround this, after server
upgrade convert your account database into some other storage – other database or file system – and back to SQLite.

NOTE: Before converting back, delete tables within the original SQLite database.
If you want to convert from SQLite to SQLite, the back conversion is not necessary.

Server Upgrade to 64-bit Version
IceWarp Server – Upgrade to 64-bit Version – MSSQL
In the case you have obtained the ODBC Warning, follow these steps:
1. Navigate to the Windows/SysWOW64 folder, run odbcad32.exe and check your current System DSN settings.
2. Navigate to the Windows/System32 folder, run odbcad32.exe and set up exactly the same System DSN as found out in the
previous step.
3. Continue the upgrade process.
4. Use the IceWarp Server Administration Console (Database Settings – Test Connection buttons) to test connections to all the
databases (Accounts, GroupWare, AntiSpam).
5. Log into IceWarp WebClient to see whether everything works correctly. Check Contacts (GroupWare) and Blacklist & Whitelist
(AntiSpam) functionality.

IceWarp Server – Upgrade to 64-bit Version – MySQL
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In the case you have obtained the MySQL Warning, follow these steps:
1. Copy the 64-bit libmysql.dll library to the Windows/System32 folder.
2. Make sure there IS NOT the 32-bit libmysql.dll library in the Windows/System32 folder.
3. Make sure there IS the 32-bit libmysql.dll library in the Windows/SysWOW64 folder.
4. Continue the upgrade process.
5. Use the IceWarp Server Administration Console (Database Settings – Test Connection buttons) to test connections to all the
databases (Accounts, GroupWare, AntiSpam).
6. If you use MySQL also for IceWarp WebClient cache and you are not able to log into IceWarp WebClient, copy the 32-bit
libmysql.dll library also to the IceWarp/PHP folder.
For more information and library download, refer to the IceWarp Support page: https://www.icewarp.com/support/iwlicense/.

Administration Interfaces
The IceWarp Server interface (Administration GUI or Console) will be your primary way of making changes and adding accounts
to IceWarp Server, at least in the short term.
The interface has been carefully designed to be intuitive and you will soon become comfortable with its layout and usage.
This section introduces the interface.

Overview
Most of the time you will use the IceWarp Server Console to manage your server.
Start – IceWarp Server – IceWarp Server Administration (config.exe in <InstallDirectory> root directory).
This runs locally on the server and its use is required for administration of certain features (Database settings, filesystem
related, properties of Control service).
There are a couple of other ways to update IceWarp Server


The Remote Administration Console (available from our website). Allows you to manage the server remotely.
Download the package.
Unpack the contents to any folder on your workstation.
When started, it will ask for connection and login details, then you will be able to work as if sitting by the server.
However, you will need to use some kind of remote access to the server (Terminal Services, pcAnywhere, VNC) and run
the administration console locally when you need to set options that are grayed out.
TIP: You can run multiple instances of config.exe allowing you to compare settings on different machines.



The WebAdmin interface
A web-based, installation-free interface for server management from any Internet-connected computer or device.
The new WebAdmin fully covers the domain administrator's agenda: creating and configuring user accounts, groups and
mailing lists.
Use a standard web browser to access http://yourserver/admin
The old WebAdmin interface is still available and has the same options as the Remote Administration Console application.
Use a standard web browser to access http://yourserver/admin/old
Initially, login is only possible with a system administrator account, but you can also grant access to it for domain
administrators, along with defined access rights.



An advanced command line tool, called Tool.exe.
This is found in <InstallDirectory>\tool.exe.
For IceWarp Linux, run ./tool.sh inside the opt/icewarp directory.
It is usually used to read or modify settings of a large set of objects, using IceWarp Server's API to directly access the
IceWarp Email Server engine, e.g. to list what users have certain options set.
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Run it without parameters for syntax and examples.

The Console Menu Bar
The File menu
contains commands related to saving and restoring configuration, you can also open any file and connect to or disconnect a
remote server.
The Accounts menu
lets you manage accounts and domains, or show information related to a selected account. The same menu appears when
you right-click user or domain listed under the Management node.
The Bookmarks menu
allows you to easily connect to remote servers. For detailed information, refer to the IceWarp Server GUI Reference –
Remote Server Administration – Bookmarks – Bookmarks Manager chapter.
The Options menu
includes settings specific to the administration console with self-explanatory meaning. Here you can lock the console to be
accessible only with administrator's login and password.
The Help menu
is where to go for additional information about the software.
The first few items open links to places of interest on our website.
The Check for new version option does just this and lets you start the download immediately.
Other items open Help topics, link to this Quick Start document and to What's New one from IceWarp website. Export
License is for backup of your license, you will need it when upgrading. Request Support will take you to the e-support web
page. About will tell you which version you are running.

Console Toolbar Customization
The Console toolbar can be customized to suit your working method.
Use Options – Customize toolbar to shape it as you like.
An intuitive dialog opens allowing you to add icons and "dividers" to your custom toolbar.

Saving Changes
You should be aware that settings are usually not saved "on-the-fly" while you are using the Console – this is to prevent
accidental modification which could cause serious problems.
To save settings at any time just press the Save button above the settings pane of the console.

NOTE: If you switch to a different tab you will be prompted to save any changes you have made. This also
happens if you close the console while changes are pending.

Languages
The administration interface is in English by default, but localization to national languages can be provided by your reseller.
A language specific, XML formatted, file is placed in the <InstallDirectory>\xml\lang directory, and this language will become
available under the Options – Languages menu item.
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Help
Press F1 anytime you are unsure or curious about what the particular option does and context-sensitive help will open just on the
right page.
For further help:


Printable documentation, in PDF format, is available on our website.



On-line version of the manual may be useful. When you are in the WebAdmin, click the "?" icon in the WebAdmin
toolbar.



Share experience with others in user forum.



Knowledge base can be accessed free of charge from menu Help – Request Support.

Getting Your IceWarp Server Online
Disable Demo Domain and Accounts
Before the server is taken on-line, do the following:


Start the Administration Console.



Choose the Domains & Accounts – Management node.



Under the Management pane expand the icewarpdemo.com domain.



Expand the Users list and select the admin@icewarpdemo.com account.



Overwrite the password in the Password and Confirm fields (always use a strong password) and click Save.



Repeat for accounts of domainadmin@icewarpdemo.com and user@icewarpdemo.com.

NOTE: As an alternate solution you could just delete the icewarpdemo.com domain, by right-clicking the
domain under Management and choosing Delete from the context menu or select Delete from the Accounts
menu.

Firewall and Routers
IceWarp Server should be located behind a hardware or at least software firewall.
The table below lists the default ports that need to be open for the basic services.
These are default port numbers, you can change them in System – Services – General, within a dialog which opens by doubleclicking the service or selecting the service from the list and clicking the Properties button.
Here you can locate port numbers for any additional services that are started.
Port to be Opened

Protocol

Module(s)

25, 587

SMTP

SMTP

465

SMTP (SSL)

SMTP

21

FTP

Control

990

FTP (SSL)

Control
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80, 32000

HTTP

Control

443

HTTP (SSL)

Control

110

POP3

POP3

995

POP3 (SSL)

POP3

143

IMAP

POP3

993

IMAP (SSL)

POP3

5222

Jabber

IM

5223

Jabber (SSL)

IM

5229

GroupWare

GW

5060

VoIP

IM
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Ensure that your server is reachable from the outside world. If it has a static IP address, this must be allowed on firewall.
Ping it from another computer.
Try tracert if ping is disabled by network settings.
Try accessing http://www.whatismyip.com/ from the server. Your IP address is displayed.
Telnet localhost 25 inside the server to see if you can connect to IceWarp Server SMTP (or to specific IP if IceWarp Server is
binded in System/Services, double click the protocol). Also try telnet outside of the server, to be sure remote mail servers will be
able to connect to your server. If localhost does not work, try 127.0.0.1 or your NAT IP, as this may depend on HOSTs file
mapping.

Dial-up Access
IceWarp Server can run via dial-up access, although you should not do this if IceWarp Server is to be a fully-featured email server.
IceWarp Server needs to be contactable by any mail server that wants to send to your domain, and should therefore be
permanently connected to Internet.
Having said that, however, IceWarp Server can be used as an email collector only and for this purpose a dial-up connection may
suffice.
If you have dial-up access, you should already have your Internet connection defined in Windows, and you now need to tell
IceWarp Server
From the IceWarp Server Console:


Navigate to System – Internet connection.



Choose the Dial-up connection radio button.



Click the Dial-up Settings button.



Select your connection from the drop-down list.



Enter your login and password details, and any connection options required by your Service Provider.
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Click Apply.



Click Connect Now if you wish IceWarp Server to connect immediately.

NOTE: You can also set up a global schedule for connecting to the internet, and individual schedules for
domains. See the documentation for more information.

DNS Records
To check that your DNS "A" and "MX" records are correctly setup, run the DNS Tool supplied with IceWarp Server:
System – Connection – General – DNS Tool button
And use the following to sets of settings to verify your records:

"A" Record Test
The DNS "A" record (or Address record) maps your domain name to your IP address.
Query: mail.yourserver.com
Type: Host address (A)
DNS: your DNS server's IP address
DNS Timeout: 5 seconds
Click Lookup.
The IP address of your IceWarp Server should be displayed.

"MX" Record Test
The DNS "MX" record (or Mail Exchange record) tells mail clients the hostname they should connect to to deliver mail:
Query: yourserver.com
Type: Mail exchange (MX)
DNS: your DNS server's IP address
DNS Timeout: 5 seconds
Click Lookup.
Your IceWarp Server hostname should appear in the list.

TIP: Other tools such as command line commands, nslookup or dig (Linux) may also be used for querying DNS
servers.

Problems with DNS
Problems are mostly caused by a firewall or router blocking the connection, or your DNS server not being reachable or configured
incorrectly. The following steps may help you diagnose the problem


Review your settings, contact your ISP or network administrator and try again.



In the Administration Console, choose System – Connection, and
1.

Check that the DNS Server field lists the DNS Server IP address you used to test the connection earlier.

2.

You can enter additional DNS Server IP addresses, delimited with a semicolon.

3.

Click the Test DNS button to test the functionality of the servers you specified.
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Setup the SMTP Service
The SMTP service is the service that sends emails to other email servers on Internet.
In the IceWarp Server console, choose Mail – General.


Select the Delivery tab



Enter Your IceWarp Server's hostname with the correct value into the Public Hostname field.



Select Use DNS lookup for direct delivery of outbound messages.



Check the Use relay server option only if you want to send messages using your ISPs (or another) mail server to send
messages.
Enter authentication details to the server with the following syntax (if you authenticate with a full email on the remote
SMTP server): username@domain.com:password@ISPhostname
If authenticating only with a username: username:password@ISPhostname



In System – Service, check that SMTP service is running.
If not, select the service from the list and click the Start button in the bottom, or right-click the service and choose Start
from the context menu.
If it does not start, it may be conflicting with another service running on its default port 25, typically Microsoft Messaging
Server. You can stop the IceWarp Server – SMTP service and telnet localhost 25 to check whether anything else responds,
so you can stop that respective service.
Stop the service that is blocking the port.

Basic Security Recommendations
Above and beyond the standard network security for your online server, you should also check that your server is not open to
abuse from spammers.
The following items are essential:


POP before SMTP – in the Mail – Security node – General tab (Ideally this option should be disabled)



Ideally define the Send out messages limit (# per day) limit per user, so that if an account gets abused, your servers does
not send more than that number of emails, possibly avoiding getting blacklisted etc. Within the Limits tab of each domain,
in the console account management, setting Send out messages limit (# per day), in the Users section of that tab, means
each user can send out that number of messages per day. Limits defined on the user’s limit tab have prevalence over the
ones set for users on the domain level.



In Mail – Security – General – Trusted IPs & Hosts, it is ideal to keep just 127.0.0.1 and the mail server’s IP. IPs defined
here can relay using your IceWarp Server without any limit, such as the ones mentioned in the previous item. If you have
systems that send out mail (relay) using your IceWarp Server, it is ideal to create an account with a certain messages out
per day limit and make your system to authenticate SMTP. If it is required for that system to send mail out without
authenticating, then you have to add the IP here.



As antispam is so complex topic, it is out of this guide scope. For detailed information, refer to the AntiSpam Reference
file.



Consider implementing this script to monitor your email queues (inbound, outbound, retry), as usually the retry queue
grows significantly in case of SMTP abuse. Script: http://forum.icewarp.com/forum/content.php?231-smtp-spam-queuemonitoring

Advanced Security Recommendations
Security – DNS Tab
Use DNSBL (DNS blackhole list):
zen.spamhaus.org (combined list)
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bl.spamcop.org
bl.barracudacentral.org (requires registration at www.barracudacentral.org)
dul.dhsbl.sorbs.net (dial-up list)
Reject if originator's IP has no rDNS
Reject if originator's domain does not exist (has no A record)

Security – Intrusion Prevention Tab
Check Active.
Block IP address that...
gets denied for relaying
establishes number of connections in 1 minute: 6
exceeds RSET session count: 5
gets listed on DNSBL
Amount of time for IP address to be blocked (Min): 30
Close blocked connections
SECUIRY – ADVANCED tab
Reject if SMTP different from Sender and Require EHLO/HELO are usually enabled.

Server Diagnostics
In the System – Services node there is a Server Diagnostics button which will perform a series of tests and report the results.
Click Server Diagnostics, the following tests are performed:


DNS server availability and address resolution.



Primary domain MX record is configured properly.



Internet connectivity by accessing the IceWarp website http://www.icewarp.com.



Tests connectivity to IceWarp’s licensing server.



Internet (SMTP, POP3 and Control) services running.



SMTP message transfer, by sending a test message to the administrator defined in the primary top (the one at the very
top in the console).

All tests should be successful.
Any failing test should be investigated.

Creating Domains and Accounts
Create New Domain
IceWarp Server is capable of supporting multiple domains, to create a new one, use the following procedure:


Select Accounts – Create New – Domain from the Main menu.



Enter the new domain name.



Enter a short description.



Select Type – Standard.
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Specify an email address for the Domain Administrator account, which will be used by the system for notification emails
and system reports.



Click Save.

Your new domain is now created and ready for use. See the Domains and Accounts Reference manual for more information.

Primary Domain
IceWarp Server supports multiple domains, but one of them must be set to be the primary domain, all the other are secondary
domains.
Functionally, there is no difference between a primary and a secondary domains, but the primary domain administrator email
address is used for sending any system notifications or reports.
With the default installation, the demo domain is the primary domain, but this can be easily changed by:


Select Domains & Accounts – Management node.



Select the domain you want to make primary one.



Select Account – Set as primary.



Right click and select Set as primary.



You have now set your primary domain.

or

TIPS
Your primary domain's administrator email address is used by IceWarp Server to send system notifications
or reports. It is recommended that a second address is specified, that is remote from this IceWarp Server,
so problem reports can be received externally.
The primary domain is always listed first in the Management pane, other domains are then listed
alphabetically.
Mail sent to a user created in primary domain does not have to include the domain name part of email
address.
If demo domain (icewarpdemo.com) exists, it is set as primary by default. You should remedy this.

Dial-up Access to ISPs Mailboxes
If you want to collect all email addressed to your domain name from a ‘catch-all’ POP3 account at your ISP, you will need to setup
one extra domain of Type: ETRN/ATRN.
(Remote accounts can be a great way also since you can setup remote accounts to fetch mail from your ISP (and keep x days of
email at the ISP). If your IceWarp Server is down, you can access emails via ISP.)
In the Value field of the domain, enter the IP address of your server if it is static, or leave it blank for a dynamic IP.
Create one user account in this domain to allow the collecting server to log in.
The username and password must match the login username and password for your ISP's POP3 account.
Under this user's properties, switch to the Options tab and tick the ETRN/ATRN account option.

Create Administrator Account
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There are three types of user account Permissions: Administrator, Domain Administrator, and Standard.
Administrator accounts (with red icons) have access to modify all server settings for all domains within your IceWarp
Server. They can create, modify and delete domains and accounts. They can create further Administrator accounts.
Administrator accounts are assigned a red icons in the accounts list for easy identification.
Domain Administrator accounts (with blue icons) can modify server settings for the domain they belong to. A domain
administrator for one domain can also be set as a domain administrator for another domain.
Standard users have black icons and only have access to some of their own account settings.
To set up your administrator account.


In the Administration Console, select the Domains & Accounts – Management node.



Select the domain you wish to add the account to.



Select Accounts – Create new – User from the main menu. The settings pane will reset to default settings.



Enter one or more aliases, separated by semi-colons. Be aware that some default administrator aliases are created for the
domain when you define it, you do not need to repeat these here, but one alias is required here.



Fill in all other details as necessary (press F1 for context sensitive help at any time).



Move to the Options tab and select Administrator or Domain Administrator from the Permissions drop down menu.



Click Save, and your administrator account is set up.



Finally, select the domain and make sure that the new administrator address is set in the Administrator – Email field.

Create New User Account
Creating a new user account is the same process as described in Create Administrator Account, except that you choose
Standard from the Permissions drop-down box.

Email Client Setup
Follow these guidelines to set up an email client (MS Outlook, Pegasus, IceWarp Desktop Client, Thunderbird, etc.).


Outgoing server – your IceWarp Server hostname.



Incoming server – your IceWarp Server hostname.



User Name – the user account Username.
NOTE: You can set IceWarp Server to require the full email address as a user name (in Domains & Accounts – Policies –
Login Policy – Login Settings).



Server Type – select POP3 or IMAP as you prefer. POP3 downloads messages to your client for reading whereas IMAP
requires a direct connection to the server.
POP3 downloads message to your client for off-line reading (suited for dial-up connection), whereas IMAP keeps
messages on the server including sent items and multiple folders (suited for permanent connection).
Be aware that this setting should match the Mailbox – Type you chose for a user.



SMTP Authentication (enabled by default, can be disabled via API).. If you have POP before SMTP unchecked, client will
authenticate with username and password (same as for POP3). This is the recommended setting.

IceWarp Server Overview
IceWarp® Server is the ultimate unified communication solution. It is extremely robust, fully-featured, and easy to use.
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Since it first hit the market 12 years ago, it has evolved into a premium messaging and collaboration platform that provides a full
range of services:


secure email service with integrated antivirus and multi-layer antispam



webclient access



GroupWare with Outlook Sync plug-in



instant messaging



VoIP server / Online Conferencing system



IceWarp Web Server



FTP



SyncML



SMS gateway



CalDAV server



integrated log analyzer



mobile access using SyncML and ActiveSync



high-performance, resource aware, and easily scalable engine



flexibility of settings



field-proven compatibility



extensible features for system integration



online conferencing

IceWarp Server is easily the best choice for a wide range of environments – offices and schools, corporations and industries, right
up to the most demanding installations at ISPs and service hosting providers.
To date, it has been adopted in more than 90 thousand installations and is servicing millions of end users world-wide.

IceWarp Server Highlights
IceWarp Server offers an unparalleled set of features, designed to meet the requirements of all deployment scenarios:


SMTP / POP3 / IMAPv4 / HTTP / LDAP / Jabber / Proxy / SNMP and SIP protocols with SSL/TLS encryption



IPv6 ready



advanced security through extensive password, protocol and usage policies, intrusion prevention and certificate
management



SyncML, ActiveSync, WebDAV, CalDAV, vCal, vCard, vFreeBusy compatible



clustering, load-balancing, distributed services



ODBC database storage for accounts, logs, and operational data, direct connecting for MySQL databases (faster)



service and system monitoring, detailed logging, log rotation, syslog server support, traffic statistics and charts



multi-threaded engines, multi-CPU system support, filesystem optimizations, enhanced memory architecture, DNS
caching



zero downtime server migration and database migration tools



integrated archive and backup tools, task schedular, tunnelling frontend

From a standalone mail server engine to the all-inclusive Enterprise Suite, licensing is flexible enough to meet every budget and
user base and keep up with your needs as you grow.
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Starting from 10 user accounts with unlimited domains and one year of upgrades and support, the license can be upgraded at
any time to allow more accounts and fitted with any of the available modules, along with the option for one year of free software
updates and upgrades (with possibility to extend this time).
Starting from 25 user version, it can be used as a high performance spam and virus filtering gateway for Microsoft Exchange or
other mail server, enhancing the reliability and security of the service. Search FAQs at https://www.icewarp.com/support/iwlicense/ for Exchange Gateway to get more details.

Before Contacting Support
Here is a checklist you can use to ensure that basic settings are correct:


Review TCP/IP settings.
Ping your mail server. If you get any packet loss, the problem may lie within your network.



Telnet your server at port 25.
You need to have telnet access enabled for this test. If you are able to ping but not telnet, the problem may be with your
firewall.



Review client settings.



Check firewall settings.



Check DNS resolution.
Ping your DNS servers from your IceWarp Server (do you get any packet loss)?
DNS server response time is crucial for processing heavy email traffic. And maybe choose a different server or add
another one to the list in case the first one timed out.
Use the supplied dnsquery.exe tool to test it as described earlier.
Try using another DNS server, just google for "public DNS server".



Check server diagnostics:
Services node – Server Diagnostics button



Check licensing:
Help menu – Licenses



Check logs:
Status – Logs, look in the Error log, SMTP log, Web/Control log, POP3 log



Restart services.



Restart the server.



Disable additional features that might be incorrectly configured, one by one to attempt to isolate a cause.



Uncheck Active in these tabs:

Rules – Content Filters
IceWarp Anti-Spam – Greylisting


Mail Service – Security – DNS – Use DNSBL



Check disk:
Use chkdsk c: /f to check your disk for possible bad sectors and repair them.

Technical Support


in Console main menu, click Help – Request support



visit https://www.icewarp.com/support/iw-license/, login or register if you do not have a username yet



email support@icewarp.com (preferably in plain text)
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Keep the first support request concise. Supply the required details like Order ID, country and which version you are
running.
Our engineers will typically ask for two things, so have them prepared or ready to send on request:


steps to reproduce the problem (or under what circumstances the error exhibits)



relevant part of log (you may need to turn the logging on first and reproduce the problem to obtain the log
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